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Logging in to your Account 
Your website administrator will set up a username and password for you to log in to the library 
website. If you need help with your account, please contact your website administrator. 

To log in to the website, go to https://yavapaievents.org/user and type in your username and 
password. (You might have to close the “branch modal” or library picker screen first.) 

 

After logging in, you will notice some additional features on the page, including the black 
administrative menu across the top of the screen that gives you access to user functions for 
your account. Each top-level item (Manage and your username) will open a secondary set of 
options in the row below. 

To log out of your account, click the Log out option on the second level of the black 
administrative menu at the top of the screen. 

 

To change your password, go to http://yavapaievents.org/user and click the Reset your 
password. You can also access your edit page by clicking the Edit profile option from the black 
administrative menu. 

https://yavapaievents.org/user
http://yavapaievents.org/user
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The edit page will allow you to change your username, email address, and/or password. If you 
are changing your password or email address, you will need to enter your current password. 

 

To update your account, click the Save button at the bottom of the page. 

 

 

 

If you have forgotten your password, you can request a new one. From the login page, click on 
the Reset your password link. 
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Enter your username or email address on the following screen and click Submit.  

 

A link will be sent to the email address associated with your account. Follow the instructions in 
the email for resetting your password to regain access to the site. 

Please note that you may be locked out of your account temporarily after five or more 
unsuccessful login attempts in quick succession. If you have forgotten your password, we 
recommend using the reset link rather than trying a series of possible passwords.  
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The Library Calendar Menu 
The administrative menu that appears at the top portion of the screen includes a Library 
Calendar menu item that includes all the calendar functions. To access this, click on Manage in 
the top level—Library Calendar will be the first menu option. 

 

Depending on your level of access, you may not see all of these options. 

This menu includes the following options: 

• Content: add closings, events, and reservations (also available from the Content>Add 
Content menu) 

• Reports: contains links to all of the available report types 
• Settings: set options for the system 
• Taxonomy: adjust calendar-specific taxonomy terms (also available from the Structure > 

Taxonomy menu)  
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Viewing the Calendar 
There are two different calendar views. Use the Upcoming and Month buttons located above 
the calendar on the right side to toggle between these views: 

Upcoming Events – displays blocks with event details 

 

Monthly Calendar – displays current month’s events; use the arrows on either side of the 
month/year to navigate the calendar 
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Each calendar view has an expandable filter that allows you to search for events. To open the 
filter, click the Filters button in the top left. To expand any of the filter’s sections, click the down 
arrow buttons. Be sure to click the Apply button after selecting filtering options. Reset will 
remove any applied filters. 

 

Which search filters are available to staff and which are available to the public can be 
configured in settings (see Settings section of this manual for more information). The available 
ones include: 

• Keyword Search: look for specific terms 
• Date: set start date for event list (only visible on Upcoming view) 
• Event Type: select to view events, closings, and/or reservations 
• Age: select age group(s); this filter is open by default when enabled to show color-

coding key 
• Program Type: select one or more event categories 
• Library Branch: select one or more locations 
• Room: select one or more rooms 
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Hovering over an event in any calendar view will load a sidebar with event information. 

 

If you are not logged in, you will only be able to see public events on any of the calendar views. 
Private events such as room reservations or staff-only events will be displayed when you are 
logged in. Some events have different styling to help you find them on the calendar. 

• Red outline – library closing (visible to all users) 
• Green outline – reservation (visibility determined by public/private status; these will 

have a note about their pending/approved and private/public status at the top) 
• Dark blue outline – staff event or other private event (visible to logged-in users) 
• Purple outline – conflicting event (visible to logged-in users) 
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Clicking any event will take you to its page, which displays all the information, a map, picture, 
and registration form (if applicable). 

 

When you are logged in, you may see additional information on event details pages that isn’t 
visible to patrons such as internal notes, room setup/teardown times, and event status. 

Patrons can use the buttons at the top to add to their calendar (iCal or Google), send an event 
reminder (not enabled when the event requires registration), print, or share the event.  

Add to My Calendar: 

 

Share: 

 

Remind Me: 
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The light blue boxes at the top will display any applicable registration information such as 
number of seats remaining, age/grade restrictions, and registration open/close dates. You may 
see additional information here when you are logged in that is not available to patrons under 
the Staff Notices section.  

 

Clicking the picture will load a full-size image. 

 

You may return to any of the calendar views from an event detail page by clicking the 
Upcoming or Month buttons located above the featured image. 
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Creating an Event 
To add an event to the calendar, use the black administrative menu located at the top of your 
screen while logged in (please note that not all roles will have access to event creation). Click 
Manage, hover over Library Calendar, Content, and then click on Create Event. 

 

This will take you to the Create Event form. Required fields are marked on the form with a red 
asterisk. Some fields may not be available based on how your library has customized the form. 
Fill out the following information: 

• Title: enter the event title 
• Administrative Settings 

o Event State: leave at – None – for a new event 
o Expected Attendance: enter the expected number of attendees for the event 
o People in Attendance: enter the number of event attendees after the event for 

recordkeeping purposes 
o Private Event: check this if the event is private, such as a staff-only event (these 

events will not display on the public calendar) 
o Internal Notes: add any internal notes about the event (these are only accessible 

by logged-in staff members, not the public) 
o Internal Categories: select any internal use categories that apply to this event; 

you can edit the display for these terms by going to Library Calendar > Settings > 
Calendar Settings and scrolling down to the Reservation Field Settings, opening 
the Internal Categories, and selecting from the Field Type choices (Checkbox List, 
Select List, or Radio List)1 

 

 

 

 

 
1 Please note that Internal Categories will only appear if terms have been created in the Taxonomy List 
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o Additional Category: if you have elected to include an additional question 
through the Structure > Taxonomy > Additional Category path, this new category 
will appear as a set of checkboxes in the Administrative Settings section of the 
Create Event and/or Create Reservation forms and in reports. This open category 
is designed to be used for any additional information you’d like to add to 
calendar entries 

 

• Room Information 
o Library Branch: select the appropriate branch for an in-house event or Offsite for 

any other events 
o Room: select the room where the event will take place 
o Room Setup: select a layout for the room2 
o Room Setup Notes: enter any notes about your selected room setup 
o Equipment: select any equipment needed for the room3 
o Offsite Address: if Offsite branch is chosen, enter an address (this will change 

the map on the event page from the library’s address to the one you enter) 
• Event Scheduling 

o Setup Time: allow a buffer at the beginning of the event for setting up the room 
(this time will not appear on the public calendar or affect the event’s start time, 
but will keep others from booking rooms during this setup or teardown) 

o Teardown Time: allow a buffer at the end of the event for cleaning up the room 
o Event Date: select the appropriate date and time for the event  
o All Day: check this box to remove the time fields from the event; marking an 

event as All Day will use default times of 12:00 a.m. to 11:59 p.m. on the 
selected dates, and these will usually be displayed first on the calendar  

o Repeat: see section on repeating events for how to use this function 
o Ignore Conflicts: if checked, the event will not conflict with other events, 

closings, or reservations. 
• Event Registration 

o Enable Registration: select this box to enable a registration form for the event 

 
2 Please note that room setup options will only appear if Room Setups have been enabled for events (in Calendar 
Settings) and if the selected room has associated room setup options. 
3 Please note that equipment options will only appear if Room Setups have been enabled for events (in Calendar 
Settings) and if the selected room has associated equipment options. 
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o Staff-Only Registration: select this box for events where staff members must 
register patrons for the event (i.e. the registration form is hidden from patrons 
and only accessible to logged-in users) 

o Special Registration Type: set registration for special cases (see descriptions on 
form—these only apply to series events) 

o Registration Settings: these settings have system defaults that you can override 
at the event level (see the section on system settings for how to set these 
defaults) 
 Seats Per Registrant: choose how many seats someone can register for 

(allows, for example, a parent to register multiple children on the form) 
 Capacity: set the total number of available seats for the program 
 Enable Waitlist: select to add registrants beyond capacity to a waitlist 
 Waitlist Capacity: set the maximum size of the waitlist 
 Reminder Date: enter a custom reminder date and time instead of using 

the default reminder time (usually 24 hours) 
 Registration Dates: enter a date and time to open registrations 

(otherwise, registration will be available as soon as the event is created) 
o Registration Mail Settings: add a custom message for any emails to registrants; 

default emails include a basic message and signature; any custom email 
information entered in this section will be added to the default message 
 Confirmation Mail: sent to registrants to confirm registration 
 Reminder Mail: sent to approved registrants before event 
 Waitlist Mail: sent to registrants placed on the waitlist 
 Waitlist Change Mail: sent to registrants who are moved from the 

waitlist to the completed list 
o Restrictions 

 Parent Required: check this box to require a parent/guardian name on 
the registration form 

 Library Card Required: check this box to require a library card number on 
the registration form 

 Disable Age Validation: check to ask registrants for their age without 
validating against an allowed range (greys out Start Age and End Age 
fields)  

 Age Restrictions: set start and end age for the event; to make an “X and 
up” event, select X for Start Age and leave End Age blank; to make an “Up 
to X” event, leave Start Age blank and select X for End Age 

 Disable Grade Validation: check to ask registrants for their grade without 
validating against an allowed range (greys out Start Grade and End Grade 
fields)  

 Grade Restrictions: set start and end grade for the event; follows same 
logic as Age Restriction field 
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 Add Custom Question: selecting this option will place a custom message 
on the registration form (if, for example, you want to ask the registrant 
how they heard about the event) 

• Make custom question required: checking this option will make 
the custom question a required element on the registration form 

• Custom question label: place your custom question in this field  
• Categories 

o Age Group: select the age group(s) for the event, which will color code the event 
on the calendar and allow it to be filtered by ages 

o Program Type: select the program type(s) for the event, which will allow it to be 
filtered by category 

• Event Details 
o Default Image: select from a set of pre-loaded images4 
o Photo/Image: upload an image to display on the event page; after uploading, a 

text field will appear where you will add alt text (an important step in making 
sure your calendar is accessible to screen readers) 

o Downloads/Attachment: upload a document for patrons to download 
o Contact Name: list a staff member that patrons can contact for additional 

information about the event (displays on public page) 
o Contact Email: list a contact email address (displays on public page) 
o Contact Phone Number: list a contact phone number (displays on public page) 
o Presenter: list name of person leading the program or any guest presenters 
o Disclaimer: add default disclaimers or notes based on selected terms5 
o Default Description: select from a set of pre-loaded descriptions6 
o Event Description: type a description of the program that will display on the 

event page; the Rich Text editor will allow you to format text and create links7 

 

 

 

 

Editing Tools: 

 
4 Please note that default images will only appear if terms have been created in the Taxonomy List 
5 Please note that disclaimers will only appear if terms have been created in the Taxonomy List. 
6 Please note that default descriptions will only appear if terms have been created in the Taxonomy List. 
7 If you use both a default description and the body field, both will appear on the event detail page with the default 
one followed by the custom one. 
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To use heading styles, highlight the desired text and click the Format dropdown menu. Choose 
the appropriate heading style from the list. To maintain consistency in text styles across the 
calendar site, only use Headings 3 and 4 inside event descriptions. 

To create links, highlight the desired text and click the link icon (labelled above). Add a URL and 
title. If you are linking to an internal page, use the path (everything that comes after 
librarymarket.com, such as /reserve-room). Please note that the CSS for your site will create 
special styling for links, so there is usually no need to add extra formatting (such as bold text or 
changing text color) to links. To have the link open in a new window, open the Advanced 
options to select Open in new window. Click Save. 

 
Once you have added all the information for your event, select which moderation state you’d 
like to place your event in.  

The workflow stages for Content Moderation include: 

• Draft – event is not published and will display with a pink background 
• Reviewed – event is not published and will display with a pink background 
• Published – event is published and visible to the public (as long as the “Private” 

checkbox isn’t selected) 

 

 

• Archived – event is not published and will display with a pink background 

Text styles (bold, italic, 
strikethrough, super-, 
and sub-script) 

Remove all formatting 
Bulleted and 
numbered lists 

Create link 
 

Heading styles 
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In many cases, which options you have for moderation states will depend on your user role. 
Changing which roles can use which states will require a permissions update, so please contact 
Library Market if you need to change content moderation access. 

Even when an event is in draft mode, the room is still booked and will trigger conflicts if 
another event is set for the same room and time. 

After saving, you’ll be taken to the event details page. 
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Creating an Event Series 
If you need to create a series of events (rather than a single one), you can do so using the 
calendar repeat settings from the Event Date field. Accessing the Create Event form and filling 
in the event information works the same as outlined in the previous section. The only 
difference is making sure to check the Repeat option under Event Date and setting parameters 
for the event series. 

 

These parameters include: 

• Repeats: select repeat duration from the first box, and then set the parameters 
o Daily: set the daily repeat period (every X days) 
o Weekly: set weekly repeat period (every X weeks) and days (works for a single 

day, such as every Monday, and multiple days, such as Tuesdays and Thursdays) 
o Monthly: set the monthly repeat period (every X months), day of repeat (third 

Wednesdays, for example) and months (if none are selected, all are assumed, 
but certain months can be skipped by checking off months from Only in) 

o Yearly: set the yearly repeat period (every X years) 
• Stop repeating: select an end for the repeat, either after a certain number of events or 

on a specific date (we recommend always setting a stop for any event series to keep the 
database from getting bogged down) 

• Exclude/include dates: choose either Exclude or Include from the dropdown menu and 
select the date; click Add to apply and repeat as needed. 

• Summary: review the repeat pattern in the Summary to make sure it is set up 
appropriately 

• RRule: lists the machine-readable key for the repeat pattern 

You may have a series that happens on random dates (i.e., there is no set pattern for the 
repeat). For these events, you will need to: 
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1. Set the repeat period to Daily 
2. Set the stop criteria to 1 occurrence 
3. Use the Include feature to add the additional dates 

 

Please note that there is an upper limit to the number of characters allowed in the RRule; we 
do not recommend adding more than 20 dates in this manner. 

If your series event will require registration, be sure to click Enable Registration on the event 
creation form. You may choose to use special registration types. Registration options for series 
events include: 

• Regular registration (-None- selected for Special Registration Type): registration is 
enabled and patrons can register for each individual event in the series; registration 
form appears on detail page of every event in the series and registration information is 
tied to each instance 

• Series registration: registration is enabled and patrons must register for the first event 
in the series; registration form appears on detail page of first event in the series and 
registration information is tied to the series (designed for skills-building classes and 
other events where patrons should attend all events in sequence); for paid events, this 
means the registrant will pay once for the entire series 

• Combine registration: registration is enabled and patrons who register for any event are 
also registered for every following event in the series; registration information is tied to 
the series (designed for events and programs like book clubs and storytimes where 
patrons register once to attend all events) 
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After you save the event, the system will test for any potential room conflicts for every event in 
the series. As long as the initial event doesn’t have a conflict, you can create the series. If there 
are any conflicts, the event page will alert you and include a link to the Event Conflict Report.  

 

You can open the edit page for the event in a new tab. At the top of the page, you will see a 
note about the conflict. This note also includes links if you would prefer to change the other 
event to resolve the conflict. 

 

Any series event detail page will have an Also Occurs On button under the date/time block. Click 
this to list other dates in the series (these dates will link to the detail page for that event). 
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Because the date/time belongs to an individual program, you are not able to adjust the time 
and date of the entire series after creating it. If you need to adjust the dates and times of an 
event series, you can either 1) edit each instance individually, or 2) make a copy of the series 
with the correct date and time and then delete the original series. If there are any registrations 
associated with any event in the series, you will need to use option 1 to retain those 
registrations. Be sure to save the copy before deleting the original series. 

Editing Existing Events 
There are several ways to edit event pages from the event detail page, which includes a series 
of buttons across the top you can access when logged in.  

 

These options include:8 

• View: look at the event detail page 
• Edit Series: loads the entire series’ Create Event form, where you can make and save 

changes (please note that you cannot change the dates/times of an event series) 
• Copy: make a copy of that event or series (clones the Create Event page) 
• Mail All Registrants: form for contacting program registrants (only shown when event 

has registrants) 
• Edit: loads that instance’s Create Event form, where you can make and save changes or 

delete the event from the system 
• Delete: remove the event from the system (only deletes the current instance, not the 

whole series) 
• Revisions: review any changes made to the event (only shown after edits or revisions 

have been made to the event) 

When using Edit, you can update any information about a single event. At the bottom, you will 
see your options for applying edits. These include: 

• Moderation State: update the publication status of the event (in most cases, defaults to 
the current state) 

• Save: apply edits to the event 

 
8 Please note that some of these options may not be visible based on your user role. 
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• Delete: remove event from the system 

 

When using Edit Series, you can update any information about the event except for the dates 
and times. At the bottom, you will see several options applying edits. These include: 

• Moderation State: update the publication status of the entire event series (in most 
cases, defaults to the current state of whatever event was used to access Edit Series) 

• Update Changed Fields: only applies changes to the fields updated on the form; in other 
words, if you update the description, it will only update the description field for all 
events 

• Update All Fields: overwrites all form fields for all events to match the changes made to 
Edit Series; the only field that won’t be overwritten is Internal Notes, as it is locked 

• Update All in Series: changes every event in the series 
• Update Future in Series: changes the selected event and all future ones 
• Delete All in Series: removes the event series from the calendar (you will need to 

confirm) 
• Delete Future in Series: removes the selected even and all future ones (you will need to 

confirm) 

 

For any event (series or not), you can add notes about your changes that will be tracked with 
the revision history. Add these to the Revision log message field in the right sidebar before 
saving any event changes. 
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Another way to access edit options is to click Content in the black user dashboard across the 
top of the screen.  

 

This loads a list of all content. Set the Content type field to Event and click the Filter button to 
list all events. You can also use those search and filtering options on the top of the screen to 
narrow your results further. 

 

From the dropdown menus in the Operations column of the list, use the edit link to go to the 
event creation form. Use the delete option to remove the event from the system.9  

 

 
9 Please note that removing an event from the system will also delete any registrations associated with that event. 
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If you need to delete multiple events, select the ones you need using the checkboxes to the left 
of the event name, select the appropriate option from the Action dropdown menu, and then 
click the Apply to selected items button. 

 

Finally, you can use the Events report to find events. To access this, hover over Library Calendar 
in the black administrative menu at the top of the screen, Reports, and then click 
Events/Reservations. 

 

This report will display a list of room uses that can be filtered and sorted using the options on 
the left side of the screen—be sure to click the Apply button at the bottom after setting these. 
Click the event title to go to the event detail page, where you can access event editing, or click 
the Edit or Delete links available from the Operations links dropdown in the last column. 
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Any of these editing options will take you back to the Event Creation form for that event, where 
you can make any of the changes you need. Be sure to click the Save button after editing the 
event.  

To update multiple events, select the appropriate boxes next to the events on either the 
content list or the reports page. Use the dropdown menu at the top to select the appropriate 
action, and then click the Apply to selected items button. 

 

Bulk operations include: 

• Change author: change ownership of the event to a different user 
• Save content: save selected content 
• Edit content: edit selected content 
• Delete content: removes item(s) from the database; you will be asked to confirm any 

deletion, and deleted items cannot be recovered without a full database backup; 
deleting an event will also remove any associated registrations 

You may choose to use publication status to hide certain events from the public until a 
particular time or as part of an internal approvals process for events. You will be able to see 
whether or not an event is published from a column in the content list or report. The detail 
page of any unpublished event will also be a pale pink color. 
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For edit content, you will need to select the appropriate field(s) to update from the next screen. 
These are organized based on the form type (Event, Reservation, etc.). After you check the box 
next to the field you want to change, the options for that field will appear underneath. Change 
the value to what you need. 

 

Scroll to the bottom and click Apply. Changes made this way will only be applied to the updated 
fields; all others will be left unchanged. 

For any field that uses checkboxes for multiple selections, please note there is an option at the 
top of the Modify Field Values page to Add values to multi-value fields. Make sure to check this 
setting if you’d like to add an option rather than replace. 
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Cancelling an Event 
If one of your events must be cancelled for any reason, you can use a state change to note this 
(rather than just deleting it from the system). Use any of the methods outlined in the previous 
section to access the Edit page for the event. From the Administrative Settings section at the 
top, change the Event State dropdown field from – None – to Cancelled. 

  

Save the event with the new cancelled state. This will clear the room from the validation 
system, allowing it to be booked for a different event or reservation, and it will mark the event 
as Cancelled on the event detail page, upcoming events view, and monthly calendar view. 

When you set an event’s state to Cancelled, you’ll see a new message and notification box. 

 

Instead of using Mail All Registrants, the system will automatically email all registrants who 
aren’t already in the Cancelled state and append the Cancellation Message you write. 
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Registering Patrons for Events 
If public registrations are enabled, patrons can register themselves for events. Staff can also 
register people using the same form. Visit the event detail page to access the registration form. 

 

Any restrictions for the event will be listed in the area above the event description. This 
includes age limitations and notes about capacity and waitlists as well as registration notices 
visible only to logged-in staff members. 

The questions on the registration form will vary depending on registration settings, but these 
include: 

• First Name: enter the registrant’s first name 
• Last Name: enter the registrant’s last name 
• Age: select registrant’s age (must be within set parameters when enabled) 
• Grade: select registrant’s age (must be within set parameters when enabled) 
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• Add Another: click to include multiple registrants (must be enabled) 
• Remove Last Registrant: click to remove a registrant when multiple registrations are 

enabled 
• Parent/Guardian Name: enter the parent/guardian for children’s events (must be 

enabled) 
• Town: select location of residence from the dropdown list 
• Email Address: enter the registrant’s email address (they will receive reminder 

notifications at this address) 
• Phone Number: enter the registrant’s phone number 
• Library Card Number: select yes if the patron has a valid library card and then enter the 

registrant’s library card number (must be enabled) 
• Special Notes: add any needed notes 

Click the Register button at the bottom of the page to complete the registration. 
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Managing Registrations 
To view a list of current registrants for an event, visit the event’s details page. If registrations 
are enabled, a list of registrants will appear at the bottom of the page when logged in. These 
will appear in the order of registration. 

 

The registrants’ names, contact information, and state will appear on this list along with the 
registration state.  

To change a registrant’s state, click Edit. Use the dropdown menu under Registrant State to 
select the appropriate state: 

• Cancelled: registrant is removed from list 
• Complete: registrant is on approved list 
• Pending: registrant is waiting for staff approval 
• Payment Pending: registrant has not completed payment process 
• Pending Waitlist: registrant without library card is in pending state for automatic 

approval 
• Waitlist: registrant is on waitlist and will be automatically moved to complete if a spot 

opens (if another person cancels or the event capacity is increased) 

Please note, in most cases you should not need to manually update Registrant States as the 
initial state assigned to the person and any transitions are usually handled automatically. 
Exceptions include Pending, which has no automatic logic assigned (i.e. registrants would need 
to be added to and removed from that state manually), and changing someone back to 
Complete from Cancelled. 
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You can also use the edit screen to make changes to the registrant’s name, parent name, 
age/grade, and contact information as well as add internal notes and payment information. Be 
sure to click the Save button at the bottom of the form after making any changes to the 
registrant’s information. 

 

To cancel a registrant from the Registrant List, choose Cancel from the Operations dropdown 
menu in the last column. 

After clicking Cancel Registration, the registration will be moved from the Complete state to 
Cancelled, but their information won’t be deleted from the system. If you need to remove a 
registrant entirely, click on the Edit link next to their name in the registrant list, which will load 
the form page, where you will have the option to delete the registration at the bottom. 

Click the View Printer-Friendly Version button under the Registrant List to generate a list view 
for printing. 
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The system also includes a tool for sending an email to everyone registered for an event. The 
Mail All Registrants button will be available from the event editing tabs only when an event has 
registrants attached. 

 

On the email page, click which group of registrants you’d like to send the email to. In most 
cases, this will be those who are in the complete (i.e. registered) state.  

 

Add a subject line and body. If you’d like to copy yourself or anyone else on the email, add that 
address to the BCC field. Click Send Mail to finish. 
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Updating Event Attendance 
Library Calendar includes a record-keeping feature for tracking program attendance. The event 
creation form includes a People in Attendance field that can be updated after the event. You 
can access the form through any of the editing options listed in the previous section to add 
attendance.10 The field is the first one under the top section for Administrative Settings. Enter 
the number of attendees in the field, and then click Save at the bottom of the screen to update. 

 

A quicker way to update the attendance is through the event detail page. When you are logged 
in to the system, one of the action buttons at the top of the page is Update attendance. 

 

 

 

 
10 If adding attendance for an event series, be sure you are accessing the form to edit the individual instance (Edit), 
not the entire series (Edit Event Series). 
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Clicking this button will open a popup where you can enter those numbers.11 Be sure to click 
Submit to save. 

 

These attendance numbers will be available from the Events and Reservations report. To run a 
monthly attendance report, go to the Events and Reservations Report. Set the filters to the 
following values: 

• Published: Any 
• Type: Event 
• Registration: Any 
• Title: blank 
• Event Start: Jan 1, 2019 
• Event End: Feb 1, 2019 
• Reservation State: none 
• Age Group: Children 
• Program Type: any 
• Branch: any 
• Room: any 
• Equipment: any 
• Room Setup: any 
• Organization: blank 
• Sort by: Event Date 
• Order: Asc 

Click Apply to set the filters. The People in Attendance column will display the values entered 
for programs. Empty fields do not yet have attendance numbers. To add attendance, click the 
event title to go to its detail page. Use the CSV button at the top of the report to download an 
Excel-readable file of your report. 

  

 
11 Please note that this feature is only available retroactively (after the event has happened). 
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Creating a Library Closing 
If the library is going to be closed for a holiday, you can create a library closing that will display 
on the calendar and also block any public meeting rooms from being booked for the closing 
duration. To add a closing, hover over Library Calendar, Content, and then click on Create 
Closing. 

 

This will take you to the Create Closing form. Required fields are marked on the form with a red 
asterisk. Fill out the following information: 

• Title: give the closing a name to display on the calendar 
• Closing Date: set the start and end date and time for the closing; you also have the 

option to mark a closing as All Day and set repeating parameters for closings 
• Ignore Conflicts: if checked, the closing will not trigger a conflict with other events, 

closings, or reservations. 
• Library Branches: select which branch to apply the closing to; all rooms in the selected 

branch(es) will be blocked from use 
• Body: add more information about your closing (this will display on the event pop-out 

and on the closing page) 

Click the Save button on the bottom of the screen to create the closing. 
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Reserving a Room 
Library Calendar includes a feature that allows patrons to use the website to submit room use 
requests. The following instructions show the process for patrons. If you access the Room 
Reservation Form while logged, in, you will see the administrative view of the form, and you 
may have access to additional options that are hidden from patrons. 

Go to https://live-yavapai.pantheonsite.io/reserve-room. You have two different options for 
reserving a room: reserving by room and reserving by time. 

 

Choosing Select a Room to Reserve will show you list of all rooms at the library. Click the title of 
the room or its Room Details button to select a date and time for your reservation. 

 

The Room Details page will display all the information about the room, including the available 
equipment and room capacity. Use the date selector to look at the room’s availability on a 
given day—make sure to click Apply Filters after changing the date. The daily calendar 
underneath will display the hours the room is available. Any greyed-out blocks are not 
available.  

 

 

 

 

https://live-yavapai.pantheonsite.io/reserve-room
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Click the + button to select a start time for your reservation and go to the application. 

 

If you choose Select a Day and Time, you can use the filters to search for rooms that are 
available on a specific date, time, and duration. Click Apply Filters to generate a list of which 
rooms fit your criteria. Click Reserve this Room to go to the application. 
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After selecting a room and a time, you will go to the Create Reservation form. Fill out this form 
with the information about your meeting, making sure to answer all required questions (noted 
with a red asterisk). The form will ask for:12 

• Title: name your event 
• Terms & Conditions: read the room reservation policy, and then check this box 
• Library Branch: select the library branch where you want to reserve a room (defaults to 

the main branch, which is the only option available) 
• Room: select your room (defaults to the one you selected on the previous screen)  
• Room Setup: select your desired room layout (options listed on room detail page) 
• Room Setup Notes: if you have any additional notes regarding setup of the room, put 

them here 
• Expected Attendance: enter the number of people expected 
• Equipment Available: check the boxes for which equipment, if any, you will need 
• Food or Drink?: check this box if you are planning to serve food or drink at your event 
• Expected Attendance: let us know how many people will be there 
• Send Reminder: uncheck this box to opt out of receiving an email reminder 
• Public: select this box to add your event to the library’s public calendar 
• Setup & Teardown Time: add a buffer time to the beginning and end of your event (15 

minutes to 1 hour) to block off extra time to set up and clean the room 
• Event Date: select your meeting start date and time (defaults to the one you selected 

on the previous screen) and your meeting end date and time 
• Library Card: enter your library card number 
• Contact Email: let us know where to send notification emails 
• Contact Name: add the name of the contact for the reservation 
• Contact Address: enter a valid mailing address 
• Contact Phone Number: let us know what number you can be reached at 
• Organization: give us the name of the organization hosing the meeting 
• Organization Type: select the organization’s type from the dropdown menu (note: you 

may be asked for additional information depending on what you select here) 
• Special Requirements: list any additional room needs for you\\]s: through the events 

calendar, through the reports module, through the content list, and via an email 
notification.  

 

 

 
12 Please note that some options may not appear based on which room and/or time you have selected and based 
on options that the library has disabled. 
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Events Calendar 

When you are logged in, reservations will be viewable on the monthly event calendar and 
labelled with their status (pending, approved, etc.). Hover for preview or click to go to the detail 
page for the reservation. 

 

Reports Module 

To access the reservations report, use the black administrative menu at the top of the screen to 
go to Library Calendar, Reports, and then click Pending Reservations. 

 

This list defaults to showing Pending reservations. To view all reservations or a different group 
of options, select the appropriate criteria from the Reservation State drop down menu at the 
top left. You can also set additional filtering and sorting criteria from this list.  

 

Be sure to click the Apply button at the bottom of the filter to apply the selected filters or 
sorting criteria. The table in this report will list the title, date, room, description, and state of 
each reservation. Click the reservation title to go to the detail page or click the Edit link from 
the dropdown menu in the Operations column in the rightmost column to load the form and 
make any changes. 
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Content List 

Drupal can generate a list of all content available on the site, which you can use to find specific 
reservations (or any other content type). To access this, click on Content in the black 
administrative menu at the top of the screen. 

 

Much like the reports, this list can be filtered using options on the top of the screen. To view 
reservations, select Reservation from the Type dropdown menu and then click the Filter button. 

 

The Content List will display the title, type, author (user who added it), updated date, available 
operations, and publication status (please note that it will not list a reservation’s state). Click 
edit under Operations to load the reservation form to make changes. 

Email Notification 

If you are listed as the staff member to receive notifications for room reservations for a 
particular branch or room, you will receive an email notification whenever someone submits a 
new reservation request. You can use the link in this email to go directly to the form to review 
and approve or cancel the request. If you are not already logged into the system when you click 
the link, you will be prompted to enter your login information before viewing the request. 
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Editing the Form 

From this form (accessed through of the ways outlined above), you can view and edit the 
request information. Click the reservation title or the View tab to go to its details page. Click the 
Edit tab to load the form and make any changes. Click the Copy tab to clone the reservation. 

 

Be sure to click the Save button at the bottom of the page after making any changes. 

Approving Reservations 
The calendar system uses states to determine whether a reservation has been approved, 
cancelled, or is pending. To approve a reservation, access its form using one of the methods 
outlined in the previous section. 

The reservation state is listed under Administrative Settings. Change the box from Pending to 
the appropriate state based on the situation.  

 

These states include: 

• Approved: reservation request is approved and on the calendar 
• Declined: reservation request is not approved and removed from the calendar 
• Cancelled: reservation request has been cancelled (generally, we recommend using this 

for reservations that were approved, but have been cancelled for logistics reasons to 
differentiate from reservations that have been declined due to not meeting library 
policies) 

• Pending: reservation request waiting for response from the library 
• Payment Pending: reservation request will be approved once room payment has been 

made 
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• No Show: patron did not show up for the reservation and did not cancel prior to the 
time of the reservation; you can use this state to track patrons who do not keep their 
reservations (please note, they will receive an email about their No Show status) 

You can also use this form to make any other changes to the reservation you may need to 
make. After you are done editing the form, click the Save button located at the bottom of the 
screen to save. The requester will receive an automatic email notification about the status of 
their reservation request. 

Accessing and Downloading Reports 
When you are logged in, you will be able to view several different report types. To access these, 
use the black administrative menu at the top of the screen to go to Library Market, and then 
click on Reports (you can also navigate to the specific report you need from the menu). 

 

The reports module includes six different types of reports: 

• Event Conflicts will list any events that conflict with the room/time of other events. 
• Events/Reservations will show all calendar items. 
• Pending Reservations will show reservation requests. 
• Registrations will show registrants for all events. 
• Room Setup will list room setups and requested equipment for events and reservations. 
• Daily Events will show all room uses for a specific day sorted by room and then time13 

  

 
13 Please note that the Daily Events Report is structured differently than the others and has different filtering 
options. 
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Standard Reports 

Use the filtering options located along the left side of any report to narrow your search results. 
For Events/Reservations, this includes publication status, type, if registrations are enabled, title, 
start/end date, reservation state, age group, program type, branch, room, and set up. You can 
select a Sort by criteria and order as well. Click the Apply button to reload the list with your 
filters.  

 

The date fields on reports will accept a variety of human-readable date/time formats. Some 
examples include: 

• Dates only 
o December 25, 2018 
o 12/25/2018 
o Dec 25 

• Dates with times 
o 12/25/2018 16:00 
o 8pm Dec 25 
o 2018-12-25 11:59:59 p.m. 

• Relative dates:  
o now 
o +1 month 
o -1 week 
o tomorrow 
o next Tuesday 

When entering dates, if elements are separated with a slash (/), the system assumes American-
style M/D/Y format; if elements are separated with a hyphen (-) or period (.), the system 
assumes European-style D-M-Y format. For US clients, we recommend using either M/D/Y or 
YYYY-MM-DD. 

You can use any combination of exact and relative entries to perform a date/time search in 
reports. When searching, keep in mind that the system will make certain assumptions if some 
information is not specified: 

• If a time is not provided, the system will assume midnight on the day selected (which 
will not include any results for that day if used as an end date) 

• If a day is not provided with a time, the system will assume the current day 
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• If a day is not provided with a month, the system will assume the 1st 
• If a year is not provided, the system will assume the current year (even if the date is in 

the past) 
• All relative date/times are calculated in relation to the current day unless they are 

added to an exact date (for example: 1/1/2019 +3 hours) 

For more information about date and time formats, including a more detailed list of examples, 
see http://php.net/manual/en/function.strtotime.php. 

Depending on the report, you’ll see different information listed in the table. This will include 
links to access the forms for any event, reservation, or registration. Any time filters are applied 
to a report, those query parameters are appended to the report URL. This means that you can 
save/bookmark any reports that you run regularly. Please note that any reports bookmarked 
with static dates in the Event Start or Event End filters will likely need to have those dates 
updated when running subsequent reports. 

Select Reset to clear all filters from the report. 

  

You can also download any generated report using the Export CSV button located at the top of 
the screen under the report type tabs (another CSV button that performs the same function is 
also located in the bottom left corner of the screen). 
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Once the export is completed, it will be automatically downloaded. You can then open the 
report in Microsoft Excel. 

Daily Events Report 

The Daily Events Report is a streamlined report designed for printing. It includes basic filters for 
date, branch, room, and event/reservation state. The report itself will list events and 
reservations sorted by room and then time.  

 

There isn’t a CSV download option with this report, but it can be printed directly from your 
browser. 
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